We’d like to take a moment to thank you for purchasing the UM-1 (16-Channel USB MIDI Interface Cable). This document explains how to set up the UM-1 system. To avoid problems and enjoy optimal performance, please carefully follow the setup instructions described in this document.

Before using this unit, carefully read the sections entitled: “USING THE UNIT SAFELY” (p. 4) and “IMPORTANT NOTES” (p. 6). These sections provide important information concerning the proper operation of the unit. Additionally, in order to feel assured that you have gained a good grasp of every feature provided by your new unit, this manual should be read in its entirety. The manual should be saved and kept on hand as a convenient reference.

Copyright © 2000 ROLAND CORPORATION
All rights reserved. No part of this publication may be reproduced in any form without the written permission of ROLAND CORPORATION.
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and
(2) This device must accept any interference received, including interference that may cause undesired operation.

Tested to Comply
With FCC Standards
For Home or Office Use

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations. Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

* Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation.
* Windows® 95 is known officially as: “Microsoft® Windows® 95 operating system.”
* Windows® 98 is known officially as: “Microsoft® Windows® 98 operating system.”
* Windows® 2000 is known officially as: “Microsoft® Windows® 2000 operating system.”
* Windows NT® is known officially as: “Microsoft® Windows NT® operating system.”
* Windows® Me is known officially as: “Microsoft® Windows® Millennium Edition operating system.”
* Apple and Macintosh are registered trademarks of Apple Computer, Inc.
* MacOS is a trademark of Apple Computer, Inc.
* Pentium is a registered trademark of Intel Corporation.
* MMX is a trademark of Intel Corporation.
* OMS is a registered trademark of Opcode Systems, Inc.
* Adobe Acrobat Reader is a trademark of Adobe Systems Incorporated.
* All product names mentioned in this document are trademarks or registered trademarks of their respective owners.
FEDERAL COMMUNICATIONS COMMISSION
RADIO FREQUENCY INTERFERENCE STATEMENT

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

– Reorient or relocate the receiving antenna.
– Increase the separation between the equipment and receiver.
– Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
– Consult the dealer or an experienced radio/TV technician for help.

Unauthorized changes or modification to this system can void the users authority to operate this equipment.
This equipment requires shielded interface cables in order to meet FCC class B Limit.

For EU Countries

This product complies with the requirements of European Directive 89/336/EEC.

For Canada

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

AVIS

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.
USING THE UNIT SAFELY

INSTRUCTIONS FOR THE PREVENTION OF FIRE, ELECTRIC SHOCK, OR INJURY TO PERSONS

About ▲ WARNING and ▼ CAUTION Notices

▲ WARNING
Used for instructions intended to alert the user to the risk of death or severe injury should the unit be used improperly.

▼ CAUTION
Used for instructions intended to alert the user to the risk of injury or material damage should the unit be used improperly.

* Material damage refers to damage or other adverse effects caused with respect to the home and all its furnishings, as well to domestic animals or pets.

About the Symbols:

▲ The ▲ symbol alerts the user to important instructions or warnings. The specific meaning of the symbol is determined by the design contained within the triangle. In the case of the symbol at left, it is used for general cautions, warnings, or alerts to danger.

▲ The ▲ symbol alerts the user to things that must never be carried out (are forbidden). The specific thing that must not be done is indicated by the design contained within the circle. In the case of the symbol at left, it means that the unit must never be disassembled.

▼ The ▼ symbol alerts the user to items that must never be carried out. The specific thing that must be done is indicated by the design contained within the circle. In the case of the symbol at left, it means that the power-cord plug must be unplugged from the outlet.

ALWAYS OBSERVE THE FOLLOWING

▲ WARNING

• Before using this unit, make sure to read the instructions below, and the Owner’s Manual.

• Do not open or perform any internal modifications on the unit.

• Do not attempt to repair the unit, or replace parts within it (except when this manual provides specific instructions directing you to do so). Refer all servicing to your retailer, the nearest Roland Service Center, or an authorized Roland distributor, as listed on the “Information” page.

• Never use or store the unit in places that are:
  ▼ ▼ ▼ • Subject to temperature extremes (e.g., direct sunlight in an enclosed vehicle, near a heating duct, on top of heat-generating equipment), or are
  • Damp (e.g., baths, washrooms, on wet floors), or are
  • Humid, or are
  • Exposed to rain, or are
  • Dusty, or are
  • Subject to high levels of vibration.
• Make sure you always have the unit placed so it is level and sure to remain stable. Never place it on stands that could wobble, or on inclined surfaces.

• Do not excessively twist or bend the USB cable and the MIDI cable, nor place heavy objects on them. Doing so can damage the cables.

• Do not allow any objects (e.g., flammable material, coins, pins), or liquids of any kind (water, soft drinks, etc.) to penetrate the unit.

• Immediately turn the power off, and request servicing by your retailer, the nearest Roland Service Center, or an authorized Roland distributor, as listed on the “Information” page when:
  • Objects have fallen into, or liquid has been spilled onto the unit; or
  • The unit has been exposed to rain (or otherwise has become wet); or
  • The unit does not appear to operate normally or exhibits a marked change in performance.

• In households with small children, an adult should provide supervision until the child is capable of following all the rules essential for the safe operation of the unit.

• Protect the unit from strong impact. (Do not drop it!)

• DO NOT play a CD-ROM disc on a conventional audio CD player. The resulting sound may be of a level that could cause permanent hearing loss. Damage to speakers or other system components may result.

• Try to prevent cords and cables from becoming entangled. Also, all cords and cables should be placed so they are out of the reach of children.

• Never climb on top of, nor place heavy objects on the unit.

• Disconnect all cords coming from external devices before moving the unit.
Important Notes

In addition to the items listed under “USING THE UNIT SAFELY” on page 4, please read and observe the following:

**Power Supply**
- Before connecting this unit to other devices, turn off the power to all units. This will help prevent malfunctions and/or damage to speakers or other devices.

**Placement**
- This device may interfere with radio and television reception. Do not use this device in the vicinity of such receivers.
- Do not expose the unit to direct sunlight, place it near devices that radiate heat, leave it inside an enclosed vehicle, or otherwise subject it to temperature extremes. Excessive heat can deform or discolor the unit.
- To avoid possible breakdown, do not use the unit in a wet area, such as an area exposed to rain or other moisture.

**Maintenance**
- For everyday cleaning wipe the unit with a soft, dry cloth or one that has been slightly dampened with water. To remove stubborn dirt, use a cloth impregnated with a mild, non-abrasive detergent. Afterwards, be sure to wipe the unit thoroughly with a soft, dry cloth.
- Never use benzine, thinner, alcohol or solvents of any kind, to avoid the possibility of discoloration and/or deformation.

**Additional Precautions**
- Use a reasonable amount of care when using this unit and its connectors. Rough handling can lead to malfunctions.
- When connecting / disconnecting all cables, grasp the connector itself—never pull on the cable. This way you will avoid causing shorts, or damage to the cable’s internal elements.
- When you need to transport the unit, package it in the box (including padding) that it came in, if possible. Otherwise, you will need to use equivalent packaging materials.
Handling CD-ROMs

- Avoid touching or scratching the shiny underside (encoded surface) of the disc. Damaged or dirty CD-ROM discs may not be read properly. Keep your discs clean using a commercially available CD cleaner.
Contents

Introduction ................................................................. 9
  Features of the UM-1 ......................................................... 9
  Contents of the Package ..................................................... 10
  Names and Functions ......................................................... 11

Connections ................................................................. 12
  Connections with the MIDI Equipment ......................... 12

Setting Up Your Computer ............................................. 14
  Windows 98 Users ............................................................ 14
  Windows 2000 Users ......................................................... 17
  Macintosh Users .............................................................. 21

Troubleshooting .......................................................... 27
  Windows 98 ................................................................. 28
  Windows 2000 .............................................................. 34
  Macintosh ................................................................. 42

Specifications ............................................................... 44

System Requirements .................................................... 45

Appendices ................................................................. A-1
  For Windows Me Users .................................................. A-1
Introduction

Features of the UM-1

The UM-1 is a USB MIDI interface cable which uses USB as its connection to your computer.

What is USB?
USB stands for Universal Serial Bus, which is a new interface for connecting various types of peripheral device to computers.
A single USB cable can be used to connect multiple peripheral devices, and data transmission speed is much faster than the serial port used on previous computers.
In addition, peripheral devices can be connected or disconnected without turning off the power, and the computer will automatically detect the device which was connected. (For some peripherals, you may need to make settings or perform other operations.)

■ Easy Connection to Your Computer
Connections to your computer can be made even when the power is turned on.

■ High-Speed Data Transmission via USB
High-speed USB connection provides excellent response even with simultaneous playback on multiple channels.

■ Power Supply Not Required
Power is supplied from the computer itself, so a separate power supply is not required.
Contents of the Package

The UM-1 package contains the following items. As soon as you open the package, please verify that all items are present. If any items are missing, please contact the dealer where you purchased the package.

- UM-1 16-Channel USB MIDI Interface Cable
- “UM-1 Driver CD-ROM”
  - This CD-ROM contains the drivers required for using UM-1, as well as readme files with additional information.
- Labels
  - You may find it useful to affix these to the cables, to facilitate identification.
- UM-1 Owner’s Manual (this document)
Names and Functions

1 USB Cable
   Connect this cable to the USB connector of your computer.

2 TO MIDI IN Cable
   Connect this to the MIDI IN connector of the sound module or other device that you wish to play from your computer.

3 TO MIDI OUT Cable
   Connect this to the MIDI OUT connector of the keyboard or other device that will transmit MIDI messages to your computer.

4 USB Indicator
   This indicator will light when the unit is connected to your computer and is ready to operate.
Connections

Here’s how to connect the UM-1 to your computer, a sound module or another MIDI device.

* This package does not include a MIDI sound module or a MIDI keyboard. You will need to provide your own, or purchase them separately.
* To prevent malfunction and/or damage to speakers or other devices, always turn down the volume, and turn off the power on all devices before making any connections.

Connections with the MIDI Equipment

1. Turn off the power of the computer, MIDI devices and the audio playback system to which you will be making connections.
2. Connect the UM-1’s TO MIDI IN cable to the MIDI Sound module’s MIDI IN connector.
3. Use audio cables to connect the MIDI Sound module’s OUTPUT L and R connectors to the input connectors (INPUT, LINE IN, AUX IN, TAPE IN etc.) of your audio playback system.
   * Be sure to connect the MIDI Sound module’s OUTPUT L and R connectors to the L and R connectors of your audio playback system without reversing the left/right connection. If L and R are exchanged, the left/right location from which sounds will be heard will be inverted.
   * Never make connections to the MIC connectors or PHONE connectors of your audio playback system.
4. If the MIDI Sound module has a Computer switch, set the Computer switch located on the rear panel of the MIDI Sound module to the “MIDI” position.
   * Before changing the setting of the MIDI Sound module’s Computer switch, be sure to turn off the power.
5. Connect the MIDI Sound module’s power cable to an electrical outlet. When you are ready to use the system, turn on the power of the MIDI Sound module and of your audio playback system.

Connecting a MIDI Keyboard

If you wish to connect a MIDI keyboard, connect the UM-1’s TO MIDI OUT cable to the MIDI OUT connector of your keyboard.

* Before turning the power off, be sure to turn down the volume of all devices to avoid speaker damage or malfunctions.
Setting Up Your Computer

In order to use the UM-1, you must first install the USB MIDI Driver. The driver is included in the "UM-1 Driver CD-ROM."

What is USB MIDI Driver?
The USB MIDI Driver is a software which passes data between the UM-1 and the application (such as sequencer software) that is running on the USB-connected computer. The USB MIDI Driver sends data from the application to the UM-1, and passes data from the UM-1 to the application.

The explanation about installing and setup the driver is organized according to the computer and MIDI driver that you are using. Please proceed to the following pages.

Windows 98 Users

* The USB MIDI Driver cannot be used with Windows 95 or Windows NT.
* With some computers, starting up Windows with the UM-1 connected can result in unstable operation. If this happens, you may be able to use the UM-1 by first starting up Windows with the UM-1 disconnected from the computer, and then afterwards connecting the UM-1.
* You may be unable to simultaneously use the UM-1 if you have an NEC-manufactured USB terminal adapter (TA) connected.
* If other programs are running, please exit all of them before you proceed with the installation.
* If you will be connecting the UM-1 to your computer simultaneously with another Roland USB-compatible device such as the UA-100, you must disconnect the UA-100 (or other device) from the USB connector before installing the USB MIDI driver. If you install the USB MIDI driver while the UA-100 etc. is connected to your computer, the USB MIDI driver may not be installed correctly.
Installing the USB MIDI Driver

1. Start Windows with all USB cables including the UM-1 (but not the mouse or keyboard) disconnected.
2. Exit all applications before performing the installation.
3. Insert the UM-1 Driver CD-ROM into your CD-ROM drive.
4. Click the Windows [Start] button, and select “Run...”
5. When “Run” appears, input the following in the “Open” area.
   D:\WIN98\SETUPINF.EXE
   * Change the drive name D: to match the drive name of your CD-ROM drive. For example if your CD-ROM drive is named Q:, you would input "Q:\WIN98\SETUPINF.EXE".
   * If you do not know the name of the drive, click the [Browse] button to check the drive name.
6. After inputting the information, click the [OK] button.
   * If a message saying that the file was not found appears, check the character string input in the “Open” area once more.
7. The “SETUPINF” dialog box will appear, and the display will indicate “Ready to install driver.”
8. Connect the USB cable of the UM-1 to your computer.
   * If the “Add New Hardware Wizard” is displayed, refer to “The “Add New Hardware Wizard” is displayed during the installation procedure.” (p. 30)
9. In some cases, the “Insert Disk” dialog box may appear. Click [OK].
10. The “New Hardware Found” dialog box will appear. In the “Copy files from” area, input “D:\WIN98” and click the [OK] button. Installation will be completed.
   * Change the drive name D: to match the drive name of your CD-ROM drive. For example if your CD-ROM drive is named Q:, you would input "Q:\WIN98".
   * If this dialog box does not appear, refer to “The “Insert Disk” dialog box is not displayed in “Installing the USB MIDI Driver”.” (p. 30)
11. As described in “Before you begin” (p. 16), make settings so that the UM-1 can be used. The UM-1 cannot be used unless these settings are made.
Before you begin

Before you use the UM-1 with the Windows Media Player

1. Open “Control Panel,” and find the “Multimedia” icon.
2. Double-click on “Multimedia” in “Control Panel.”
3. Click the [MIDI] tab, and in “MIDI Output,” select “1:Roland UM-1 MIDI.”
   * If the above “1:Roland UM-1 MIDI” cannot be selected, a problem may have occurred.
   Refer to “Troubleshooting.” (p. 27)
4. Click the [OK] button.
5. Connect the TO MIDI IN cable of the UM-1 to a MIDI sound module (such as the Roland SC series).
6. Start up Windows Media Player or Media Player, select a MIDI file, and play back.

Before you use the UM-1 with an application

In the application(s) that you intend to use, specify the MIDI device they are to use. (For details on this setting, refer to the owner’s manual for your application.) The MIDI device names and their corresponding cables will be as follows:

- **MIDI OUT device**
  - Roland UM-1 MIDI — UM-1 TO MIDI IN cable

- **MIDI IN device**
  - Roland UM-1 MIDI — UM-1 TO MIDI OUT cable

* If you are unable to select “Roland UM-1 MIDI” in the MIDI settings of the application, a problem may have occurred. Refer to “Troubleshooting.” (p. 27)

Changing the settings

To access the settings dialog box, go to “Control panel” — “Multimedia” — “Devices,” and in “MIDI Devices and Instruments,” select [MIDI for Roland UM-1 MIDI] — “Properties” — “Settings.”

* Normally, you should leave the “Light Load” check box selected. The setting changes will take effect after you disconnect, then re-connect the USB cable of the UM-1.
Windows 2000 Users

* Only one unit can be used at a time.
* With some computers, starting up Windows with the UM-1 connected can result in unstable operation. If this happens, you may be able to use the UM-1 by first starting up Windows with the UM-1 disconnected from the computer, and then afterwards connecting the UM-1.
* If other programs are running, please exit all of them before you proceed with the installation.
* If you will be connecting the UM-1 to your computer simultaneously with another Roland USB-compatible device such as the UA-100, you must disconnect the UA-100 (or other device) from the USB connector before installing the USB MIDI driver. If you install the USB MIDI driver while the UA-100 etc. is connected to your computer, the USB MIDI driver may not be installed correctly.

Installing the USB MIDI Driver

To install the driver, you must log on to Windows as the Administrator or other user with the privileges of the Administrators group. For more information regarding this, consult your computer system administrator.

1. Start Windows with all USB cables including the UM-1 (but not the mouse or keyboard) disconnected.
2. Log onto Windows as an Administrator, or other user that is a member of the Administrators group.
3. Exit all applications before performing the installation.
4. Open the “Control Panel,” and double-click “System.”
5. Click the [Hardware] tab, and then click the [Driver Signing] button. The “Driver Signing Options” dialog box will appear.
6. Make sure that “File signature verification” is set to “Ignore.” If it is set to “Ignore,” click [OK]. If not, make a note of the current setting, then change it to “Ignore” and click the [OK] button.

* Caution regarding the “File signature verification” setting
  • If the “File signature verification” setting is left at “Warn,” the “Digital Signature Not Found” dialog box will appear during the installation, but you should simply click [Yes] and continue the installation.
7. Click the [OK] button to close “System Properties.”
8. Insert the UM-1 Driver CD-ROM into your CD-ROM drive.
9. Click the Windows [Start] button, and select “Run...”
10. When “Run” appears, input the following in the “Open” area.

```
D:\WIN2000\SETUPINF.EXE
```
* Change the drive name D: to match the drive name of your CD-ROM drive. For example if your CD-ROM drive is named Q:, you would input “Q:\WIN2000\SETUPINF.EXE.”
* If you do not know the name of the drive, click the [Browse] button to check the drive name.
11. After inputting the information, click the [OK] button.
* If a message saying that the file was not found appears, check the character string input in the “Open” area once more.
12. The “SETUPINF” dialog box will appear, and the display will indicate “Ready to install the driver.”
13. Connect the USB cable of the UM-1 to your computer.
* If in step 6 the “File signature verification” setting is not set to “Ignore,” the “Digital Signature Not Found” dialog box will appear. If this occurs, refer to “the caution given in step 6,” and take the appropriate action.
14. The “Insert Disk” dialog box will appear. Click the [OK] button.
* If this dialog box does not appear, refer to “The “Insert Disk” dialog box is not displayed in “Installing the USB MIDI Driver”.” (p. 37)
15. The “Files Needed” dialog box will appear. In the “Copy files from” area, input “D:\WIN2000” and click the [OK] button.
* Change the drive name D: to match the drive name of your CD-ROM drive. For example if your CD-ROM drive is named Q:, you would input “Q:\WIN2000.”
* If you were not able to perform the installation according to this procedure, use the procedure in “Tried other troubleshooting tips but the UM-1 still does not work?” (p. 40) to delete the driver, and then perform the installation once again.
16. The “Found New Hardware Wizard” will appear. Make sure that “Roland UM-1 USB Driver” is displayed, and click the [Finish] button.
17. The “System Settings Change” dialog box will appear. Click the [Yes] button and re-start Windows.

18. If you changed the setting for “Verify file signature” in step 6, set it back to the previous setting. (To restore the setting, the Administrator or user belonging to the Administrators group must log on to Windows.)

19. As described in “Before you begin” (p. 19), make settings so that the UM-1 can be used. The UM-1 cannot be used unless these settings are made.

Before you begin

Before you use the UM-1 with the Windows Media Player

1. Double-click “Sounds and Multimedia” in “Control Panel.”
2. Click the [Audio] tab, and in “MIDI Music Playback,” select “1: Roland UM-1 MIDI.”
   * If the above “1: Roland UM-1 MIDI” cannot be selected, a problem may have occurred. Refer to “Troubleshooting.” (p. 27)
3. Click the [OK] button to close “Sounds and Multimedia Properties.”
4. Connect the TO MIDI IN cable of the UM-1 to a MIDI sound module (such as the Roland SC series).
5. Open “Windows Media Player,” select a MIDI file, then play back the file.

Before you use the UM-1 with an application

In the application(s) that you intend to use, specify the MIDI device they are to use. (For details on this setting, refer to the owner’s manual for your application.)

The MIDI device names and their corresponding cables will be as follows:

MIDI OUT device
Roland UM-1 MIDI — UM-1 TO MIDI IN cable

MIDI IN device
Roland UM-1 MIDI — UM-1 TO MIDI OUT cable

* If you are unable to select “Roland UM-1 MIDI” in the MIDI settings of the application, a problem may have occurred. Refer to “Troubleshooting.” (p. 27)
To change the settings

To change or verify settings
In order to change the driver settings, you must log on to Windows as the Administrator or other user in the Administrators group. For more information regarding this, consult your computer system administrator.

1. When changing driver settings, always make sure to first quit all applications using the UM-1. This is unnecessary when only checking the settings.
2. Open the “Control Panel,” and double-click “System.”
3. Click the [Hardware] tab, and then click the [Device Manager] button.
4. Double-click “Sound, video and game controllers.”
5. Double-click “Roland UM-1 USB Driver.”
6. Click the [Properties] tab, and in the Multimedia Devices field, double-click “MIDI Devices and Instruments.”
7. Select “Roland UM-1 USB Driver,” and click the [Properties] button.
8. Click the [Settings] button to access the “Roland UM-1 USB Driver Settings” dialog box.
9. To modify the settings, make the changes and click the [OK] button. To simply check the settings, be sure to click the [Cancel] button after viewing the settings.

About the items in the Settings dialog box

The “Light Load” check box
Normally, you should leave the check box cleared.

* The setting changes will take effect after you disconnect, then re-connect the USB cable of the UM-1.
Macintosh Users

Using OMS on the Macintosh

Installing OMS

* If the OMS 2.3.7 or a later version is installed, you do not need to install this version of OMS. Proceed to the next step and install the USB MIDI Driver.
* Check the version of OMS required for your software. If the software requires later versions, follow the instructions in the owner’s manual of your software and install OMS.
* Disconnect the USB cable of the UM-1 from your Macintosh before powering up.

1. Start up your Macintosh.
2. Insert the UM-1 Driver CD-ROM into the CD-ROM drive.
3. In the “UM-1 Drivers”–“UM-1-Driver E”–“OMS”–“OMS 2.3.7” folder of the CD-ROM, find “Install OMS 2.3.7” and double-click the icon.
4. Follow the on-screen instructions to perform the installation.
5. After the installation completes, re-start the Macintosh.

Installing the USB MIDI Driver

* The USB MIDI Driver (for OMS) requires Opcode OMS 2.3.5 or later. If this is not installed, you must first install OMS, and then install the USB MIDI Driver.
* 64 MB or more memory is required. Virtual memory cannot be used. You must make memory setting to turn virtual memory “off” before using this.
* Disconnect the USB cable of the UM-1 from your Macintosh before powering up.

1. Start up your Macintosh.
2. Insert the UM-1 Driver CD-ROM into the CD-ROM drive.
3. Connect the USB cable to the USB port on your Macintosh. A dialog indicating that the software cannot be found will appear, but you should simply click [OK].
* If you connect the UM-1 to the USB port on the keypad of your Macintosh, this message will appear: “The USB device ‘Unknown Device’ cannot operate because it needs more power than is available.” Make sure to connect the UM-1 to a USB connector on the computer itself.
4. In the “UM-1 Drivers”–“UM-1 Driver E”–“OMS” of the CD-ROM, double-click the “UM-1 OMS Driver-E Installer” icon.
5. Follow the on-screen instructions to perform the installation.
If OMS is not correctly installed, the driver installation process will be halted. If this occurs, exit the driver installation process, and install OMS. After installing OMS, install the driver once again.

6. After the installation completes, re-start your Macintosh.

Setting up OMS

* Before setting up OMS, change the setting of the MIDI device connected to the UM-1 to avoid transmitting the MIDI time clock signal. For instructions on how to change the setting, refer to the owner's manual of the MIDI device you have.

* When you install the USB MIDI Driver and set up OMS, two MIDI devices named “Roland UM-1” will be detected. One of them is the MIDI device connected to the UM-1, and the other is the UM-1 MIDI interface itself. You need to change the name of the MIDI device connected to the UM-1 so that the two can be distinguished. Please refer to the next procedures.

1. Make sure that the UM-1 is connected to your Macintosh, and power up your Macintosh.
2. In the Opcode folder, open the OMS Applications folder, and double-click the OMS Setup icon.
3. If the AppleTalk dialog box appears, select [Turn It Off].
4. Click [OK] in the dialog box that appears next.
5. The “Create a New Studio Setup” dialog box will appear. Click [OK].

* If the above dialog box does not appear, select “New Studio Setup” from the File menu.
6. The OMS Driver Search dialog box will appear. Click [Search].

7. When the search has been completed, make sure that the OMS Driver Setup dialog box lists the Roland UM-1, and click [OK].

8. A dialog box will appear, allowing you to save the settings in a file. Input the desired filename, and click [Save].

9. The Studio Setup windows will open. Change the device name to “Port 1” for the MIDI device connected to the UM-1. Click the device name, and you will be able to change it.

* Device icons shown in the dialog may be different depending on your setup.

10. Connect a sound module to the TO MIDI IN cable of the UM-1, select “Test Studio” in the “Studio” menu, and check it to hear whether sound is produced.

* The following step will cause a relatively loud sound to be produced by the sound module, so turn down the volume of your sound module before continuing.
11. In the Studio Setup window, place the mouse pointer on the “Port 1” icon, and the pointer will change to the shape of an eighth note. While the pointer has changed its shape, click the icon to make sure that sound is produced by the sound module.

* Selecting “Roland UM-1” on the MIDI sequencer software does not generate any sounds from the sound module connected to the UM-1. Specify “Port 1” to send/receive MIDI data to/from the equipment connected to the MIDI cable of the UM-1.

12. After verifying that sound is produced from the sound module, select [Quit] from the “File” menu to exit OMS Setup. A dialog box will appear recommending that you save, so click [Save].

13. Re-start your Macintosh.
    This completes the setting up OMS.

To learn more about OMS

If you would like to learn more about OMS, please refer to “OMS_2.3_Mac.pdf” (on-line manual) located in the “UM-1 Drivers”–“UM-1 Driver E”–“OMS”–“OMS 2.3.7” folder on the CD-ROM. In order to read “OMS_2.3_Mac.pdf,” you will need the Adobe Acrobat Reader. To install it, double-click “Reader Installer” which is found in the CD-ROM.
Using FreeMIDI on the Macintosh

Installing the USB MIDI Driver

* The USB MIDI Driver (for FreeMIDI) included on the disc is provided as an additional module that allows the UM-1 to be used with FreeMIDI. Refer to the owner’s manual of FreeMIDI, and install it on the startup hard disk before installing the USB MIDI Driver.

* 64 MB or more memory is required. Virtual memory cannot be used. You must make memory settings to turn virtual memory “off” before using this.

* Disconnect the USB cable of the UM-1 from Macintosh before powering up.

1. Start up the Macintosh.
2. Insert the UM-1 Driver CD-ROM into the CD-ROM drive.
4. Follow the on-screen instructions to perform the installation.
5. After the installation is complete, re-start the Macintosh.
6. Connect the USB cable of the UM-1 to your Macintosh.

* If you connect the UM-1 to the USB port on the keyboard of your Macintosh, this message will appear: “The USB device "Unknown Device" cannot operate because it needs more power than is available.” Make sure to connect the UM-1 to a USB connector on the computer itself.

Setting up FreeMIDI

1. Open the “FreeMIDI Applications” folder, and double-click the “FreeMIDI Setup” icon.

* There will be a version number following “FreeMIDI Setup” as the actual icon name.

2. The first time FreeMIDI is started up, a “Welcome to FreeMIDI!” dialog box will appear. Click [Continue]. If this is the second or later time, select “FreeMIDI Preferences” from the File menu.

3. In the “FreeMIDI Preferences” dialog box, check “UM-1 Port” which is located below UM-1 Driver in MIDI Configuration, and click [OK].

* If the dialog box does not show “UM-1 Driver,” check whether the UM-1 is connected correctly, and start up FreeMIDI Setup once again.

4. The About Quick Start dialog box will appear. Click [Continue].
5. In the dialog box that appears, select the MIDI equipment that is connected to the UM-1.
   Manufacturer
   Select the manufacturer of your MIDI equipment. If the appropriate manufacturer does not appear in the list, select “Other.”
   Model
   Select the model of your MIDI equipment. If the appropriate model does not appear in the list, select “Other.”
6. Click [Add].
7. When settings are complete, click [Done].
8. If you selected “Other” for Model, double-click the appropriate icon in the setting window to make settings for your MIDI equipment. For details refer to the documentation included with your software.
9. From the File menu, select Save, and save your settings.
   This completes the setting up FreeMIDI.
Troubleshooting

* Please read the Readme file in the UM-1 Driver CD-ROM. You can get any additional information not written in the owner’s manual from the Readme file.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 98 Users</td>
<td>p. 28</td>
</tr>
<tr>
<td>Cannot install/uninstall/use the driver</td>
<td>28</td>
</tr>
<tr>
<td>Cannot select the UM-1 device (Roland UM-1 MIDI)</td>
<td>30</td>
</tr>
<tr>
<td>Cannot play back/record</td>
<td>31</td>
</tr>
<tr>
<td>Part of the playback is wrong: e.g., notes are broken off prematurely, or some notes are lost</td>
<td>32</td>
</tr>
<tr>
<td>Tried other troubleshooting tips but the UM-1 still does not work</td>
<td></td>
</tr>
<tr>
<td>Windows 2000 Users</td>
<td>p. 34</td>
</tr>
<tr>
<td>Cannot install/uninstall/use the driver</td>
<td>34</td>
</tr>
<tr>
<td>Cannot select the UM-1 device (Roland UM-1 MIDI)</td>
<td>37</td>
</tr>
<tr>
<td>Cannot play back/record</td>
<td>38</td>
</tr>
<tr>
<td>Part of the playback is wrong: e.g., notes are broken off prematurely, or some notes are lost</td>
<td>39</td>
</tr>
<tr>
<td>The “Digital Signature Not Found” dialog box appears</td>
<td>39</td>
</tr>
<tr>
<td>You are asked for the driver file even though it has already been installed</td>
<td>39</td>
</tr>
<tr>
<td>Cannot use two or more units simultaneously</td>
<td>40</td>
</tr>
<tr>
<td>Other</td>
<td></td>
</tr>
<tr>
<td>Tried other troubleshooting tips but the UM-1 still does not work</td>
<td></td>
</tr>
<tr>
<td>Windows 2000 Users</td>
<td>p. 42</td>
</tr>
<tr>
<td>(Uninstalling the USB MIDI Driver)</td>
<td>40</td>
</tr>
<tr>
<td>Macintosh Users</td>
<td>p. 42</td>
</tr>
<tr>
<td>Cannot install the USB MIDI driver</td>
<td>42</td>
</tr>
<tr>
<td>UM-1 is not detected when setting up OMS or FreeMIDI</td>
<td>42</td>
</tr>
<tr>
<td>No sound</td>
<td>42</td>
</tr>
<tr>
<td>The UM-1 does not recover correctly from sleep mode</td>
<td>43</td>
</tr>
<tr>
<td>No sound when testing OMS</td>
<td>43</td>
</tr>
</tbody>
</table>
Windows 98

Cannot install/uninstall/use the driver

Check with the driver installed on the computer

If you can’t use the UM-1 even though you’ve installed the driver, the driver might not be installed correctly. Use the following procedure to check.

1. Start Windows with all USB cables including the UM-1 (but not the mouse or keyboard) disconnected.
2. Connect the USB cable of the UM-1 to your computer.
3. Open the “Control Panel” and double-click “System.”
4. Click the [Device Manager] tab, and double-click “Sound, video and game controllers.”
5. Does the display show “Roland UM-1 USB Driver”? 

If this is not displayed, refer to step 5 and following of “Does the “Device Manager” show “? Composite USB Device,” “? USB Device,” “? USB Device,” or “USB Composite Device”? ” (p. 28).

If this display appears, but a yellow “!” or red “x” is attached, refer to step 7 and following of “Does the “Device Manager” show a yellow “!” or red “x” for the “Roland UM-1 USB Driver”? ” (p. 29).

If there is no problem with the display but the UM-1 cannot be used, refer to “Is the UM-1 MIDI device name displayed?” (p. 30).

Does the “Device Manager” show “? Composite USB Device,” “? USB Device,” “! USB Device,” or “USB Composite Device”? 

If the installation was not performed according to the procedure specified in “Installing the USB MIDI Driver” (p. 15), the UM-1 will not be correctly recognized by Windows, and will not operate.

Use the following procedure to re-install the driver.

1. Start Windows with all USB cables including the UM-1 (but not the mouse or keyboard) disconnected.
2. Connect the USB cable of the UM-1 to your computer.
3. Open the “Control Panel” and double-click “System.”
4. Click the [Device Manager] tab.
5. Check whether “Other devices,” “Sound, video and game controllers,” or “Universal Serial Bus controllers” contain a line indicating “? Composite USB Device,” “?? USB Device,” “!” USB Device,” or “USB Composite Device.”
   If you do not find any such item listed in these places, it is likely that the problem is due to other causes, so please refer to other troubleshooting items.

6. If you find a line indicating “? Composite USB Device,” “?? USB Device,” “!” USB Device,” or “USB Composite Device,” click that line and then click the [Remove] button.

7. The “Confirm Device Removal” dialog box will appear. Review the contents of the dialog box, and click the [OK] button.
   In the same way, delete every “? Composite USB Device,” “?? USB Device,” “!” USB Device,” or “USB Composite Device” that you find.

8. Disconnect the USB cable of the UM-1.


10. Install the driver as described in “Installing the USB MIDI Driver.” (p. 15)

**Does the “Device Manager” show a yellow “!” or red “x” for the “Roland UM-1 USB Driver”?**

Use the following procedure to check.

1. Start Windows with all USB cables including the UM-1 (but not the mouse or keyboard) disconnected.

2. Connect the USB cable of the UM-1 to your computer.

3. Open the “Control Panel,” and double-click “System.”

4. Click the [Device Manager] tab.

5. Double-click “Sound, video and game controllers” to see the list of devices.

6. In the list, select “Roland UM-1 USB Driver” and check whether a yellow “!” or red “x” are displayed.

7. If there is a yellow “!” or red “x,” exit all applications that are using the UM-1, and then re-connect the USB cable of the UM-1.

8. If this does not solve the problem or if a red “x” is displayed, use the procedure described in “Tried other troubleshooting tips but the UM-1 still does not work” (p. 30) to delete the driver, and then use the procedure described in “Installing the USB MID Driver” (p. 15) to re-install the driver.
Is the UM-1 MIDI device name displayed?
If the device name is not displayed, exit all applications that are using the UM-1, and re-connect the USB cable of the UM-1.

If this does not solve the problem, use the procedure described in “Tried other troubleshooting tips but the UM-1 still does not work” (p. 30) to delete the driver, and then use the procedure described in “Installing the USB MIDI Driver” (p. 15) to re-install the driver.

The “Add New Hardware Wizard” is displayed during the installation procedure.
Use the following procedure to re-install the driver.
1. Click the [Cancel] button.
2. Disconnect the USB cable of the UM-1.
3. Re-start Windows.
4. Install the driver as described in “Installing the USB MIDI Driver.” (p. 15)

The “Insert Disk” dialog box is not displayed in “Installing the USB MIDI Driver.” (p. 15)
The following situations are possible.
* Refer to “Does the “Device Manager” show “?” Composite USB Device,” “?” USB Device,” “!” USB Device,” or “USB Composite Device”? (p. 28)
* Refer to “Does the “Device Manager” show a yellow “!” or red “x” for the “Roland UM-1 USB Driver”? ” (p. 29)
* Was the driver deleted completely? Delete the driver as described in “Tried other troubleshooting tips but the UM-1 still does not work” (p. 30), and re-install the driver as described in “Installing the USB MIDI Driver.” (p. 15)
* Are your computer supplying sufficient current?
If insufficient current is being supplied to the UM-1, connection is not possible.
• The power conservation mode settings of your computer may be limiting the current supplied to the USB, so check these settings.

Cannot select the UM-1 device (Roland UM-1 MIDI)
Was the driver installed correctly?
Check the driver as described in “Check with the driver installed on the computer.” (p. 28)
Did the computer enter a standby or hibernate mode while the UM-1 was connected?
If the computer entered a standby or hibernate mode while the UM-1 was connected, it may not operate correctly. In this case, after resuming, exit all applications that are using the UM-1, and disconnect the USB cable of the UM-1 and re-connect it.

Was the USB cable disconnected and re-connected while the UM-1 was being used?
If the USB cable is disconnected and re-connected while the UM-1 is in use, it may no longer operate correctly. If this occurs, exit all applications that are using the UM-1, and disconnect/re-connect the USB cable of the UM-1.

On some computers, if the UM-1 is connected while Windows starts up, the USB MIDI Driver will not be loaded correctly, and it will not be possible to use the UM-1.
If this occurs, start up Windows before you connect the UM-1.

Cannot play back/record

Was the driver installed correctly?
Check the driver as described in “Check with the driver installed on the computer.” (p. 28)

Did you make settings as described in “Before you begin” (p. 16) so that the UM-1 could be used?
The UM-1 cannot be used unless you make these settings. Refer to “Before you use the UM-1 with the Windows Media Player” (p. 16) and “Before you use the UM-1 with an application.” (p. 16)

Could you have entered standby or hibernate mode during playback or recording?
If you entered standby or hibernate mode during playback or recording, it will no longer be possible to play back or record from the sound module. Exit all currently playing or recording applications, and disconnect/re-connect the USB cable of the UM-1.
During playback or recording, did you disconnect and re-connect the USB cable?
If you disconnect and re-connect the USB cable during playback or recording, the UM-1 will no longer be able to play back or record. Stop playback or recording, and then start playback or recording once again. If you are still unable to play back or record, quit all programs that are using the UM-1, then disconnect/re-connect the USB cable of the UM-1.

Part of the playback is wrong: e.g., notes are broken off prematurely, or some notes are lost
Such problems may be solved if you uncheck the “Light Load” check box. Please refer to “Changing the settings.” (p. 16)

* The modified setting will take effect after the USB cable of the UM-1 is disconnected and re-connected. Unless you experience problems, use the checked (initial) setting.

Tried other troubleshooting tips but the UM-1 still does not work
Uninstall the USB MIDI Driver and follow the “Installing the USB MIDI Driver” (p. 15) to re-install the driver.

Uninstalling the USB MIDI Driver
1. Start Windows with all USB cables including the UM-1 (but not the mouse or keyboard) disconnected.
2. Connect the USB cable of the UM-1 to your computer.
3. Exit all applications before performing the uninstallation.
4. Delete the driver.
   4-1. Open the “Control Panel,” and double-click “System.”
   4-2. Click the [Device Manager] tab.
   4-3. Double-click “Sound, video and game controllers” to see the list of devices.
   4-4. From the list, select “Roland UM-1 USB Driver” and click [Remove].
   * If the list does not show “Roland UM-1 USB Driver,” refer to “Cannot install/uninstall/use the driver.” (p. 28)
   4-5. A “Confirm Device Removal” dialog box will appear. Make sure that “Roland UM-1 USB Driver” is shown in the dialog box, and click the [OK] button.
   4-6. In “System Properties,” click [Close].
5. Disconnect the USB cable of the UM-1.

6. Delete the driver settings files.
   6-1. Click “Start” → “Settings” → “Folder Options,” and click the [View] tab.
   6-2. In “Advanced settings,” uncheck “Hide file extensions for known file types”
       and check “Show all files” in “Hidden files.” Then click [OK].
   6-3. Click “Start” → “Program” → “Explorer” to start up, and if “Rdif0009.inf” is
       in the “\Windows\Inf” folder, select that, then right-click and choose
       “Delete” from the menu that appears.
   6-4. If “RolandRdif0009.inf” is in the “\Windows\Inf\Other” folder, select that,
       then right-click and choose “Delete” from the menu that appears.
   6-5. Select “Rdin0009.ini” in the “\Windows” folder, then right-click and choose
       “Delete” from the menu that appears.
   6-6. In the “\Windows\System” folder, successively “Rddp0009.dat,”
       “Rdtrv0009.drv,” “Rdrcx0089.vxd,” and “Rdwm00009.sys,” and for each file,
       right-click and choose “Delete” from the menu that appears.

7. Re-start Windows.
Windows 2000

Cannot install/uninstall/use the driver

Are you logged onto Windows with the appropriate user rights?
In order to install/uninstall/re-install drivers, you must be logged onto Windows as an
Administrator, or other user that is a member of the Administrators group. For more
information regarding this, consult your computer system administrator.

Did you make “Driver Signing” settings?
In order to install/re-install drivers, “File signature verification” needs to be carried out.
Use the following procedure to check.
1. Open the “Control Panel” and double-click “System.”
2. Click the [Hardware] tab, and then click the [Driver Signing] button. The “Driver Signing
   Options” dialog box will appear.
3. Make sure that “File signature verification” is set to “Ignore.” If it is set to “Ignore,” click
   [OK]. If not, make a note of the current setting; then change it to “Ignore” and click the
   [OK] button.
   * Caution regarding the “File signature verification” setting
     • If the “File signature verification” setting is left at “Warn,” the “Digital Signature Not
       Found” dialog box will appear during the installation, but you should simply click [Yes]
       and continue the installation.
     • If the “File signature verification” setting is set to “Block,” the “Digital Signature Not
       Found” dialog box will appear during the installation; click the [OK] button. “Found
       New Hardware Wizard” will appear, so click the [Finish] button to close the wizard,
       and re-install as described in “Is “? USB Device” shown in “Device Manager”?” (p. 35)
4. Click the [OK] button to close “System Properties.”

Check with the driver installed on the computer
If you can’t use the UM-1 even though you’ve installed the driver, the driver might not be
installed correctly. Use the following procedure to check.
1. Start Windows with all USB cables including the UM-1(but not the mouse or keyboard)
disconnected.
2. Log onto Windows as an Administrator, or other user that is a member of the Administrators group.
3. Connect the USB cable of the UM-1 to your computer.
4. Open the “Control Panel” and double-click on “System.”
5. Click the [Hardware] tab, and then click the [Device Manager] button.
6. Double-click “Sound, video and game controllers.”
7. Does the display show “Roland UM-1 USB Driver”?
   * If this is not displayed, refer to “Is “? USB Device” shown in “Device Manager”? (p. 35)
   * If this display appears, but a yellow “!” or red “x” is attached, refer to ‘Does the “Device Manager” show a yellow “!” or red “x” for the “Roland UM-1 USB Driver”? (p. 36)
   * If there is no problem with the display but the UM-1 cannot be used, refer to “Is the UM-1 MIDI device name displayed?” (p. 36)

Is “? USB Device” shown in “Device Manager”??

If the installation was not performed according to the procedure specified in “Installing the USB MIDI Driver” (p. 17), the UM-1 will not be correctly recognized by Windows, and will not operate. Use the following procedure to re-install the driver.
1. Start Windows with all USB cables including the UM-1 (but not the mouse or keyboard) disconnected.
2. Log onto Windows as an Administrator, or other user that is a member of the Administrators group.
3. Connect the USB cable of the UM-1 to your computer.
4. Open the “Control Panel” and double-click on “System.”
5. Click the [Hardware] tab, and then click the [Device Manager] button.
6. Check to see if “? USB Device” is displayed under “Other Devices.” If it is not found there, check if there is a “? USB Device” listed under “Sound, video and game controllers.” If you do not find any such item listed in these places, it is likely that the problem is due to other causes, so please refer to other troubleshooting items.
7. If you find a “? USB Device” line, right-click and then choose “Uninstall” from the menu that appears.
8. A “Confirm Device Removal” dialog box will appear. Make sure that “USB Device” is shown in the dialog box, and click the [OK] button.
9. Disconnect the USB cable of the UM-1.
11. Install the driver as described in “Installing the USB MIDI Driver” (p. 17)

Does the “Device Manager” show a yellow “!” or red “x” for the “Roland UM-1 USB Driver”? Use the following procedure to check.
1. Start Windows with all USB cables including the UM-1 (but not the mouse or keyboard) disconnected.
2. Log onto Windows as an Administrator, or other user that is a member of the Administrators group.
3. Connect the USB cable of the UM-1 to your computer.
4. Open the “Control Panel” and double-click on “System.”
5. Click the [Hardware] tab, and then click the [Device Manager] button.
6. Double-click “Sound, video and game controllers.”
7. In the list, select “Roland UM-1 USB Driver” and check whether a yellow “!” or red “x” are displayed.
8. If there is a yellow “!”, exit all applications that are using the UM-1, and then re-connect the USB cable of the UM-1.
9. If this does not solve the problem or if a red “x” is displayed, use the procedure described in “Tried other troubleshooting tips but the UM-1 still does not work” (p. 40) to delete the driver, and then use the procedure described in “Installing the USB MIDI Driver” (p. 17) to re-install the driver.

Is the UM-1 MIDI device name displayed? If the device name is not displayed, exit all applications that are using the UM-1, and re-connect the USB cable of the UM-1.

If this does not solve the problem, use the procedure described in “Tried other troubleshooting tips but the UM-1 still does not work” (p. 40) to delete the driver, and then use the procedure described in “Installing the USB MIDI Driver” (p. 17) to re-install the driver.
The “Insert Disk” dialog box is not displayed in “Installing the USB MIDI Driver.”
(p. 17)

The following situations are possible.
* Refer to “Is ? USB Device” shown in “Device Manager”? (p. 35)
* Refer to “Does the “Device Manager” show a yellow “!” or red “x” for the “Roland UM-1 USB Driver”? ”
* Was the driver deleted completely? Delete the driver as described in “Tried other troubleshooting tips but the UM-1 still does not work” (p. 40), and re-install the driver as described in “Installing the USB MIDI Driver.” (p. 17)
* Are your computer supplying sufficient current?
  If insufficient current is being supplied to the UM-1, connection is not possible.
  • The power conservation mode settings of your computer may be limiting the current supplied to the USB, so check these settings.

Are two or more UM-1 units connected?
Use the following procedure.
1. Exit all applications.
2. Shut down Windows.
3. Start Windows with all USB cables including the UM-1 (but not the mouse or keyboard) disconnected.
4. Connect only one UM-1 unit to your computer, and check the operation.

Cannot select the UM-1 device (Roland UM-1 MIDI)

Was the driver installed correctly?
Check the driver as described in “Check with the driver installed on the computer.” (p. 34)

Did the computer enter a standby or hibernate mode while the UM-1 was connected?
If the computer entered a standby or hibernate mode while the UM-1 was connected, it may not operate correctly. In this case, after resuming, exit all applications that are using the UM-1, and disconnect the USB cable of the UM-1 and re-connect it.
Was the USB cable disconnected and re-connected while the UM-1 was being used?
If the USB cable is disconnected and re-connected while the UM-1 is in use, it may no longer operate correctly. If this occurs, exit all applications that are using the UM-1, and disconnect/re-connect the USB cable of the UM-1.

On some computers, if the UM-1 is connected while Windows starts up, the USB MIDI Driver will not be loaded correctly, and it will not be possible to use the UM-1.
If this occurs, start up Windows before you connect the UM-1.

Cannot play back/record
Was the driver installed correctly?
Check the driver as described in “Check with the driver installed on the computer.” (p. 34)

Did you make settings as described in “Before you begin” (p. 19) so that the USB driver could be used?
The UM-1 cannot be used unless you make these settings. Refer to the sections on “Before you use the UM-1 with the Windows Media Player” (p. 19) and “Before you use the UM-1 with an application.” (p. 19)

Could you have entered standby or hibernate mode during playback or recording?
If you entered standby or hibernate mode during playback or recording, it will no longer be possible to play back or record from the sound module. Exit all currently playing or recording applications, and disconnect/re-connect the USB cable of the UM-1.

During playback or recording, did you disconnect and re-connect the USB cable?
If you disconnect and re-connect the USB cable during playback or recording, the UM-1 will no longer be able to play back or record. Stop playback or recording, and then start playback or recording once again. If you are still unable to play back or record, quit all programs that are using the UM-1, then disconnect/re-connect the USB cable of the UM-1.
Part of the playback is wrong: e.g., notes are broken off prematurely, or some notes are lost
Such problems may be solved if you check the “Light Load” check box.
If you wish to modify or verify the settings, use the procedure described in “To change or verify settings.” (p. 20)

* The modified setting will take effect after the USB cable of the UM-1 is disconnected and re-connected. Unless you experience problems, use the unchecked (initial) setting.

Make the following settings. Performance may be improved.
1. Double-click on “System” in “Control Panel.”
2. Click the [Advanced] tab, and then click the [Performance Options] button. Select “Background services,” and click the [OK] button.
3. Click the [OK] button to close “System Properties.”

The “Digital Signature Not Found” dialog box appears
If the “Digital Signature Not Found” dialog box appears, refer to “Did you make “Driver Signing” settings?” (p. 34)

You are asked for the driver file even though it has already been installed
If you change the USB connector to which the UM-1 is connected, you may be asked for the driver file.
This is normal behavior, and does not indicate a problem. Use the following procedure to install the driver.

* If the “Digital Signature Not Found” dialog box appears, refer to “Did you make “Driver Signing” settings?” (p. 34)

1. When the “Insert disk” dialog box appears, click the [OK] button.
* If the “Insert disk” dialog box does not appear, but the “Add New Hardware” dialog box appears, refer to “Are you logged onto Windows with the appropriate user rights?” (p. 34)
2. In the “Copy files from” area, either input the folder that contains the driver, or click the [Browse] button to access the “Locate File” dialog box, move to the folder that contains the driver, and click the [Open] button. Then click the [OK] button. (Example: D: \WIN2000)

3. The “Found New Hardware Wizard” will appear. Make sure that “Roland UM-1 USB Driver” is displayed, and click the [Finish] button.

4. The “System Settings Change” dialog box will appear. Click the [Yes] button to re-start the computer.

If two or more UM-1 units are connected, you may be asked for the driver file. This driver can be used only for one unit at a time.
When the “Insert disk” dialog box appears, click the [Cancel] button. Then follow the procedure for “Are two or more UM-1 units connected?” (p. 37)

**Cannot use two or more units simultaneously**
This driver can be used with only one unit at a time.
The second and subsequent UM-1 cannot be used. Follow the procedure for “Are two or more UM-1 units connected?” (p. 37)

**Other**
Display indicates “The currently installed Device Driver does not support Plug and Play.”
This message may appear if you click the [Resources] tab of “Roland UM-1 USB Driver Properties.”

**Tried other troubleshooting tips but the UM-1 still does not work**
To uninstall the driver, you must log on to Windows as the Administrator or other user belonging to the Administrators group. For more information regarding this, consult your computer system administrator.
Uninstall the USB MIDI Driver, and follow the “Installing the USB MIDI Driver” (p. 17) to re-install the driver.

**Uninstalling the USB MIDI Driver**
1. Start Windows with all USB cables including the UM-1 (but not the mouse or keyboard) disconnected.
2. Log onto Windows as an Administrator, or other user that is a member of the Administrators group.
3. Connect the USB cable of the UM-1 to your computer.
4. Exit all applications before performing the uninstallation.
5. Open the “Control Panel” and double-click on “System.”
6. Click the [Hardware] tab, and then click the [Device Manager] button.
7. Double-click “Sound, video and game controllers” to see the list of devices.
8. From the list, right-click “Roland UM-1 USB Driver” Then choose “Uninstall” from the menu that appears.
   * If the list does not show “Roland UM-1 USB Driver,” refer to “Cannot install/uninstall/use the driver.” (p. 34)
9. A “Confirm Device Removal” dialog box will appear. Make sure that “Roland UM-1 USB Driver” is shown in the dialog box, and click the [OK] button.
10. Close the “Device Manager,” and in “System Properties” click the [OK] button.
11. Disconnect the USB cable of the UM-1.
12. Re-start Windows.
Macintosh

Cannot install the USB MIDI driver
Did you exit all other programs?
Exit all currently-running programs.

Cannot install the USB MIDI Driver
Install OMS or FreeMIDI before installing the USB MIDI Driver.
USB MIDI Driver cannot be installed without installing OMS or FreeMIDI first. Refer to the
instruction on the “Installing OMS” (p. 21) or the owner’s manual of your software, and
install OMS or FreeMIDI.

UM-1 is not detected when setting up OMS or FreeMIDI
Was the UM-1 recognized?
• Disconnect the USB-cable, and then re-connect it.
• If another USB device is connected, try connecting only the UM-1.
• It is possible that the computer did not correctly recognize or initialize the UM-1.
  Leave the USB cable of the UM-1 connected, and re-start your Macintosh. If the
  connection is still not achieved, exit your Macintosh and turn off the power of the
  computer. Then turn on the power of the computer once again, and start up your
  Macintosh.
• The computer cannot recognize the UM-1 when the USB-connector of Macintosh’s
  keyboard is used. Re-connect the USB cable to the USB-connector of the main body.

Are your computer supplying sufficient current?
If insufficient current is being supplied to the UM-1, connection is not possible.
• The power conservation mode settings of your computer may be limiting the current
  supplied to the USB, so check these settings.

No sound
Are the USB cable, MIDI cables and audio cables connected correctly?
Refer to “Connections with the MIDI Equipment” (p. 12), and connect the cables correctly.
Are the volume controls of your sound module, audio system, and application raised?
Check each of the volume controls.

Are the sound module settings correct?
Refer to the owner’s manual of your MIDI sound module for more information on settings.

Do you use only OMS?
When installing both FreeMIDI and OMS on your Macintosh, OMS cannot operate correctly. Delete the files related to FreeMIDI from the “Extensions” folder.

Check the OMS settings
Refer to “Setting up OMS” (p. 22) and check the settings. Make sure that the devices connected to the UM-1’s TO MIDI OUT/TO MIDI IN cables are selected in the music application software.

The UM-1 does not recover correctly from sleep mode.
After your Macintosh has been in sleep mode, exit the software and re-start it.
* We recommend that you make Energy saving settings in the Control panel so that your computer does not enter sleep mode.

No sound when testing OMS
Is the setting of the sound module correct?
Refer to the owner’s manual of your MIDI sound module connected to the computer, and check with the settings (such as the computer switch).

Are the volume controls of your sound module and the audio system raised?
check each of the volume controls.

Is the Studio Setup valid?
If a diamond (◊) does not appear in the window’s title bar, it means that the Studio Setup is disabled. Select the “Make Current” from the OMS File menu.

Re-start your Macintosh
Re-start your Macintosh, and check with the settings.
## Specifications

**UM-1: 16-Channel USB MIDI Interface Cable**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cables</td>
<td>TO MIDI IN/TO MIDI OUT cable (IN x 1, OUT x 1)</td>
</tr>
<tr>
<td></td>
<td>USB cable</td>
</tr>
<tr>
<td>Power Supply</td>
<td>USB bus-powered (Supplied from Computer)</td>
</tr>
<tr>
<td>Current Draw</td>
<td>150mA (during operation)</td>
</tr>
<tr>
<td>Dimensions</td>
<td>89.9 (W) x 52.52 (D) x 18.6 (H) mm</td>
</tr>
<tr>
<td></td>
<td>3-9/16 (W) x 2-1/16 (D) x 3/4 (H) inches</td>
</tr>
<tr>
<td>Weight</td>
<td>170 g/6 oz.</td>
</tr>
<tr>
<td>Cable Length</td>
<td>TO MIDI IN/TO MIDI OUT cable 1200 mm</td>
</tr>
<tr>
<td></td>
<td>USB cable 600 mm</td>
</tr>
<tr>
<td>Accessories</td>
<td>UM-1 Driver CD-ROM</td>
</tr>
<tr>
<td></td>
<td>Owner’s Manual</td>
</tr>
<tr>
<td></td>
<td>Labels</td>
</tr>
</tbody>
</table>

*In the interest of product improvement, the specifications and/or appearance of this unit are subject to change without prior notice.*
## System Requirements

### Windows

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Microsoft® Windows® 98 (includes Second Edition),</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Me,</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 2000 Professional</td>
</tr>
<tr>
<td>Computer:</td>
<td>Windows 98/Me/2000 Professional compatible computer with a</td>
</tr>
<tr>
<td></td>
<td>USB connector conforming to USB specifications Ver.1.1</td>
</tr>
<tr>
<td>CPU/clock:</td>
<td>MMX® Pentium® processor 166 MHz or higher</td>
</tr>
<tr>
<td>Memory (RAM):</td>
<td>32 MB or more</td>
</tr>
<tr>
<td></td>
<td>(64MB or more for Windows® 2000)</td>
</tr>
</tbody>
</table>

### Macintosh

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Mac OS 8.5, 8.6 or 9.x</td>
</tr>
<tr>
<td>Computer:</td>
<td>Apple Macintosh series having USB ports as the standard application</td>
</tr>
<tr>
<td>CPU/clock:</td>
<td>PowerPC G3 233 MHz or higher</td>
</tr>
<tr>
<td>Memory (RAM):</td>
<td>64 MB or more</td>
</tr>
</tbody>
</table>
For Windows Me Users

Installing the USB MIDI Driver

1. Remove all USB cables from the computer (except for the keyboard and mouse), and start up Windows.
2. Before installing the driver, quit all applications.
3. Connect the computer and the device you are using with a USB cable.
5. Place the CD-ROM provided with your device in the CD-ROM drive.
6. After a moment, a search is made automatically for the driver, and when detected, installation of the driver begins.
   * If after a few moments nothing appears to be happening, click the [Next] button.
7. When the dialog announcing that installation of the driver has been completed appears, click on [Done].

Refer to the following section “Driver Settings” and make the settings for using your Roland device with your computer. It is these settings that make this possible.

Driver Settings

1. From the Windows [Start] menu, select “Control Panels” in “Settings.”
2. Double-click on the [Sound and Multimedia] icon in “Control Panels.”
   * If you cannot find the [Sound and Multimedia] icon, click on “Display all Control Panel options.” in “Control Panels.”
3. Click on the [Audio] tab in the “Sound and Multimedia Properties” dialog, and select the item with the name of the device you are using in the “MIDI Music Playback” field.
   * If using multiple devices, refer to the Owner’s Manual.
4. Click on the [OK] button to close “Sound and Multimedia Properties.”
Uninstalling the USB MIDI Driver

1. Remove all USB cables from the computer (except for the keyboard and mouse), and start up Windows.
2. After connecting the computer and the device you are using with a USB cable, turn on the power to the device. However, the UM-1, UM-2, and UM-4 do not need to be turned on.
3. Before uninstalling the driver, quit all applications.
5. Double-click on the [System] icon in "Control Panels."
   * If you cannot find the [System] icon, click on "Display all Control Panel options." in "Control Panels."
6. Click on the [Device Manager] tab.
7. Double-click on "Sound, video and game controllers" to display the device list.
8. Select the name of the device you are using from the list and click on the "Remove" button.
9. Click on the [OK] button in the "Confirm Device Removal" dialog box.
10. After confirming that the device name does not appear under "Sound, video and game controllers," click on the [Close] button to close "System Properties."
11. Disconnect the USB cable from the computer.
12. Double-click on "Folder Options" in "Control Panels," then click on the "Display" tab.
13. Uncheck "Do not display extensions for registered files" in the "Advanced..." items of the "Display" tab, then click on "Show all files and folders" and click on the [OK] button.
14. From the Windows [Start] menu, go to "Find" and select "Files and Folders."
15. Under "Search in" select "Local Hard Drives" and enter the items as shown below in the "File or Folder Name" field, the click on the [Find Now] button.
   ✽ ✽ ✽
16. If the following files are among those files found, right-click and select "Remove" from the menu that appears.
   * All may not be display, but this does not indicate any problem.
   * No distinction is made between upper- and lower-case letters in the displayed file names.
   * Please do not remove any files other than those specified below.
      Rdf0009.inf, RolandRdf0009.inf, Rddp0009.dat
17. Restart Windows.